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IntroductionIntroduction  

This training guide covers the Provider portal features for providers, their staff, and for office 
administrators. 

 

The Provider web portal allows providers and their office staff the ability to conduct the following 
activities online: 

 Checking claim/pre-estimate/referral status online. 

 Viewing CEOB (Consolidated Explanation of Benefits) payment information. 

 Submitting claims claim/pre-estimates/referrals online. 

 Looking up member eligibility. 

 Accessing information for all provider offices with a single login. 

 Accessing online provider directories. 

 Communicating with DentaQuest using a secure messaging system. 

 If you are a Provider Super User you can add, edit, and delete users. 

 

The Provider portal allows you to view your information: 

 General information 

 Location information 

 Languages 

 Specialties 

 Network affiliations 

 Office locations 

 Affiliated providers for an office 

NNoottee::    Contact DentaQuest to update any of this information. 
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UUsseerr  AAccccoouunnttss  OOvveerrvviieeww  
Each provider group is set up with three separate tiers. The primary Provider Super User for 
your provider group is responsible for setting up the users for your practice and determining 
what access they should be allowed. Your access is determined based on your tier and security 
role.  Your Tier Assignment determines the offices and providers to which you have access. 
Your Security Role controls what functions you are allowed to perform. The following outlines 
the tier structure and the security roles. 

TTiieerr  SSttrruuccttuurree  
A user assigned to the… is able to access information… 

Business Entity (tier 1) for all providers at all locations. You should assign a user at this 
level if you want them to be able to view and/or maintain 
information for your entire organization (all service 
offices/locations) and all providers. 

SO - Service Office (tier 2) for all providers in a specific location. You should assign a user 
at this level if you have staff members who view and/or maintain 
information for a specific service office/location and the 
providers assigned to the specific service office/location. 

Individual Dentist (tier 3) Users are not assigned to this tier. This tier lists the individual 
dentists. 

NNoottee::    Remember, Service Office users can only access information for the dentists 
assigned to that service office. 

SSeeccuurriittyy  RRoolleess  
If a user is assigned the 
role of… 

     at the tier they have been assigned they are able to… 

1 - Provider Super User  Create and manage user accounts for staff  

 Perform Member Eligibility searches 

 View EOBs (Explanation of Benefits) 

 Check status of Claims/Pre-estimates/Referrals 

 Enter and submit Claims and Pre-Estimates/Referrals 

2 - Provider Office User  Perform Member Eligibility searches 

 View EOBs (Explanation of Benefits) 

 Check status of Claims/Pre-estimates/Referrals 

 Enter and submit Claims and Pre-Estimates/Referrals 

3 - Provider Office User, 
No Remit 

 Perform Member Eligibility searches 

 Check status of Claims/Pre-estimates/Referrals 

 Enter and submit Claims and Pre-Estimates/Referrals 
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GGuuiiddee  CCoonnvveennttiioonnss  
The following conventions are used throughout this training guide: 

1. Notes 

NNoottee::    All notes providing you with additional information appear in a grey box. 

2. The names of fields, buttons, menus, and other elements that appear in the portal 
appear in Bold Format. 

PPoorrttaall  FFiieellddss  
The tab key allows you to move from field to field, minimizing mouse use. 

NNoottee::    Required fields are marked with a red asterisk (*). 

EEnntteerr  IInnffoorrmmaattiioonn  iinnttoo  aa  FFiieelldd  
1. Move your mouse pointer over the field and click once.  

NNoottee::    The term “click” in this guide refers to a left-click using your mouse. The term “right-
click” is used when a right-click is necessary.   

2. Once the cursor is flashing in the field, begin entering data.  

NNoottee::    Only use the Enter key after you enter all the information for the current page. 
Hitting the Enter key submits the page. Use the Tab key or your mouse to move to 
the next field. 

UUssee  aa  DDrroopp--ddoowwnn  LLiisstt  
Many fields are configured as drop-down lists that allow you to select from a list of options.  

1. Click the arrow in the field ( ) to display the drop-down list. 

2. Click the option you want with your mouse. 

 

NNoottee::    You can use the Down-Arrow key to highlight the option you want, and then hit the 
Tab key to select it. You can also type the first letter of the name to move the cursor 
to the beginning of names that begin with that letter and then scroll from there. 
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EEnntteerr  aa  DDaattee  
Enter dates in the following format: MMDDYYYY. For example, enter 08202018 for August 20, 
2018.   

SSeelleecctt  aa  DDaattee  UUssiinngg  tthhee  PPoopp--UUpp  CCaalleennddaarr  

1. Click the Calendar icon  next to the date field for which you are selecting a date. 

 

2. In the pop-up Calendar that appears, navigate to the date you want to select: 

a. Click on the left or right arrow to select a month. 

b. Click on the left or right arrow to select a year. 

c. Click the number for the day of the month you want to select on the calendar to 
enter that date in the Date field. 

The calendar closes and the Date field is populated with the date you selected. 

 

VViieeww  HHeellpp  TTeexxtt  ffoorr  aa  FFiieelldd  

Fields that have associated help text appear with a help icon  displayed next to the field. 
Move your mouse pointer over the help icon to display the help text. 
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RReessuulltt  CCoolluummnn  HHeeaaddiinnggss  
Many of the pages in this portal have the following structure: 

1. A Search section 

2. A Results section 

Whenever you see a Results section in this portal, you can sort the information by clicking on 
one of the underlined column headings. The data is sorted in alphabetical or numeric order 
depending on the type of data in the column.  

NNoottee::    To reverse the order of the sort, click the column heading a second time. 

 

  

UUssiinngg  tthhee  BBrreeaaddccrruummbb  TTrraaiill  
The breadcrumb trail in the upper-left corner of your page lists all of the previous pages that you 
have navigated through to reach the current page. Use the breadcrumb trail to return to any 
previous page by clicking the link for the page to which you want to return. 

WWAARRNNIINNGG::    Do not use your browser’s Back button. The portal does not support the use of a 
browser’s back button, which is why the breadcrumb trail is available for you to 
return to a previous page. 
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CCoommmmoonn  TToooollss  
There are common tools you can use on various pages throughout the portal when available. 

1. The Download File link allows you to download tables of information in a comma 
separated values (.csv) text file. Use Excel or another application that can handle (.csv) 
text files to view the file. 

a. Click the Download File link. 

 

b. In the File Download dialog window that appears, click Save. 

c. In the Save As dialog window that appears, select the location where you want to 
save the file, change the file name if necessary, and then click Save. 

2. The Printer Friendly Format link allows you to print the information on the current page 
in a printer friendly format.  

a. Click the Printer Friendly Format link. 

 

A new browser window opens with the information on the current page in printer 
friendly format. 

b. Click File > Print… from the new browser window menu to print the page on your 
configured printer. 

3. There are navigation arrows beneath the Results section when the results of a search 
do not fit on a single page. 

To navigate between pages for multi-page search results, use the left and right arrows. 
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WWeebb  PPoorrttaall  LLooggiinn  PPaaggee  
The Login page allows you to login to the Provider Portal. 

LLooggggiinngg  iinnttoo  YYoouurr  PPoorrttaall  
To login to the portal, you must have a unique username and password, which you receive from 
your supervisor. 

LLoogg  iinnttoo  YYoouurr  PPoorrttaall    
1. Use your web browser to navigate to the DentaQuest website at www.dentaquest.com. 

2. Click on Dentists in the upper-center of the web page and choose Dentists. 

              

 

http://www.dentaquest.com/
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3. Click on the state where the Employer Group is located. 
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4. In the Dentist Page section, either: 

1. Click on Dentist Login if you have already registered to use the portal or 

2. Click on Register here if you have not registered yet. 
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5. On the portal login page that appears, enter your username in the User ID field, your 
password in the Password field, and then click the Login button. 

NNoottee::    If this does not work or you do not know your User ID, contact your Office 
Administrator or DentaQuest. 

NNoottee::    If you do not have or remember your password, you can request your password 
from DentaQuest with the Forgot Password link. 

 

 

 

 

6. The first time you log in, you are prompted to enter a new password: 

NNoottee::    Your password needs to be 8 to 16 characters, contain at least one upper case, one 

lower case and one number and/or special character. You cannot use the following 

special characters: (;, \, { , }, [, ], “, %, ~, *, : ). You are prompted to change your 

password every sixty days. You cannot use any of your last ten passwords. 

a. Type a new password into Password field. 

b. Type the same password into the Confirm Password field. 

c. Click the Submit button below these fields. 
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7. The first time you log in, you are prompted to accept the Web Portal Provider User 
Agreement:  

a. If you accept the terms, select the Yes, I agree with the statement option. 

b. Click the Next button.  

Your Home page appears after a successful login. 
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RReettrriieevviinngg  YYoouurr  PPaasssswwoorrdd  
If you do not know your password, you can request it by clicking the Forgot Password? Link. 

RReettrriieevvee  YYoouurr  PPaasssswwoorrdd    
1. Click the Forgot Password? Link below the Login button on the left side of the page. 

 

The Request Password page appears. 

2. Type your User ID (Username) into the User ID field. 

3. Type your last name into the User Last Name field. 

4. Type your first name into the User First Name field. 

5. Click the Next button.  

If Username, User Last Name, and First Name match the records, the Request 
Password Response page appears. 

 

NNoottee::    If this does not work or you do not know your User ID, you need to contact 
DentaQuest or your Office Administrator. 

6. On the Request Password Response page, click the Send Password button to have 
your password sent to your email address. 
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Provider Home PageProvider Home Page  

The Home page has the following elements: 

1. Portal Menus – The Administration, Claims/Pre-Estimates, Patient, Tools, Privacy 
Policy, and Provider User Agreement menus are displayed along the left side of the 
Provider portal. 

2. Welcome – This section contains the DentaQuest welcome message. 

3. Plan Messages – This section contains any plan messages from DentaQuest to your 
plan. You can access message details when available by clicking the message link. This 
section only displays if there is a message.  

4. Resources – This section links to various health resources. 

5. DentaQuest Contact Information – This section contains DentaQuest’s contact 
information.  

6. Message Center – This section contains messages sent to you from DentaQuest.   

NNoottee::    The Message Center only appears on your Home page if there are messages in 
your Inbox. 

7. FAQ – This link opens the View FAQ page where you can view frequently asked 
questions. 

8. Sign Out – This link signs you out when you are done.  

9. Event Calendar – This link opens the Event Calendar. 

10. Related Documents – This link opens the Document List page. 
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Portal Menus 
The Portal Menus are where you access the functional areas of the portal: 

1. Administration (if you are a Super User) – this menu contains the following menu 
items: 

 Dentist List – view dental office and individual dentist details. 

 User List – view and edit user accounts. (Only available to Super Users, see 
Provider Administration Guide for additional information)  

 Billed Amount List – add, edit or view billed amount lists. 

 Billed Amount Associations – associate billed amount lists with your service office 
and individual dentists (if different from the service office list). 

 Electronic Fund Transfer (Only available to Super Users, see Provider 
Administration Guide for additional information) - to enroll in EFT via the web portal, 
providers must: Complete online EFT form and include attach the required 
documentation under file attachment.  

2. Claims/Pre-Estimates– this menu contains the following menu items: 

 Claim/Pre-Estimate Status Search – search for the status of a claim or pre-
estimate. 

 Consolidated Explanation of Benefits – search for claim payment information 
associated to a specific claim. 

 Dental Claim Entry – submit a claim. 

 Dental Pre-Estimate Entry – submit a pre-estimate. 

 Dental Claim Confirmation Report – view and/or print a report for all the claims 
and pre-estimates you have submitted for the day. 

3. Patient – this menu contains the following menu items: 

 Member Eligibility Search – perform an eligibility search for one or more members. 

4. Tools – this menu contains the following menu items: 

 User Profile – edit your user account. 

 Inbox – view secure messages sent to you from DentaQuest. 

NNoottee::    Also available via the Message Center section of your Home page. 

 Contact DentaQuest – send secure messages to DentaQuest. 

 Find a Dentist – search for a specific type of dentist, view detailed provider 
information, and get directions to a dentist’s office. 

5. Privacy Policy – this menu allows you to view the DentaQuest Privacy Policy. 

6. Provider User Agreement – this menu allows you to view the DentaQuest Terms of 
Use. 
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UUssiinngg  tthhee  MMeessssaaggee  CCeenntteerr  
The Message Center appears on your Home page when you have messages in your Inbox. 
You can view a specific message by clicking its Subject link or you can click the Inbox link to 
go to your Inbox. For more information, see “Using Your Inbox”. 
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Administration Menu Administration Menu   

Click the Administration menu on the left-side of the page to display the menu items.  

 

UUssiinngg  tthhee  DDeennttiisstt  LLiisstt  
The Administration > Dentist List menu allows you to open the Dentist List page and to 
search for and select provider offices or specific dentists that are affiliated with your business 
entity depending on your Tier Assignment (you can only view your assigned tier and below). 
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PPrroovviiddeerr  OOffffiiccee  TTiieerrss  

The tiers are listed on the Dentist List page: 

NNoottee::    This is one of the main differences between the Dentist List and the Find a Dentist 
pages. The Find a Dentist page never shows Business Entity (Tier 1) information. 

1. Business Entity 

This is considered Tier 1 and users created for the business entity office can see and 
access provider information for all office locations, so they see all three tiers. 

The business entity appears on the Dental List page with a Record Type of Business. 

2. Service Office/Location 

This is considered a Tier 2 level and users created for a service office can only see and 
access provider information and dentists assigned to that location, so they will not see 
tier 1 (the business entity) or other tier 2 service offices. 

A service office appears on the Dental List page with a Record Type of Location. If a 
service office has an NPI, it is a type 2 NPI (also known as a subpart NPI). NPI may not 
be not be populated if they do not have a type 2 NPI.  

3. Individual Dentist 

Individual dentists are considered Tier 3. 

A dentist appears on the Dental List page with a Record Type of Dentist. Any relevant 
IDs, such as a state license, NPI (National Provider Identifier), Medicaid and Medicare 
IDs will be listed in the Provider ID field. 
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SSeeaarrcchh  ffoorr  aa  DDeennttiisstt//OOffffiiccee  

1. If you see the Dentist/Office Name link you are looking for in the Results section, click 
on it to open the Dentist Detail page and view details for that office or dentist. Otherwise 
continue to search for the dentist or office you want. 

2. On the Dentist List page, none of the search fields are mandatory, so type in as much 
information as you need to narrow down your search results. By default all results 
initially appear in the list. 

 If you know the dentist’s last name or the name of the dental office, type it into the 
Dentist Last Name/Office Name field. 

 If you know the dentist’s first name, type it into the Dentist First Name field. 

 You can type the city into the City field. 

 You can select the state from the State drop-down list.  

 You can type the phone number into the Contact Phone field. 

3. Click the Search button. 

 

4. Click a Dentist/Office Name link to open the Dentist Detail page and view details for 
that office or dentist. 
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TThhee  DDeennttiisstt  DDeettaaiill  PPaaggee  
This page contains the following sections (use the scroll-bar to view all sections): 

NNoottee::    The information shown for each section varies depending on the tier you are viewing 
(business entity, service office, or individual dentist). 

 General Information – This section lists all the general information for a dentist, service 
office, or business entity. 

 Provider Identifiers – This section lists any provider identifiers for a dentist or business 
entity (Medicaid/Medicare IDs, State License, NPI, and EIN) and whether or not an 
identifier is the primary identifier for HIPAA requirements.  

 Provider Languages – This section lists the languages for a dentist or service office 
and whether it’s their primary language, when available.  

NNoottee::    For a service office, all the languages for the dentists in that office are listed. 

 Specialties & Certifications – This section lists all the specialties and certificates for a 
dentist or service office. It has no entries for a business entity. Click a Specialties & 
Certifications link to view the associated web site outside of the portal. For example, 
click the ABO link to see The American Board of Orthodontics’ website.  

 Provider Locations – This section lists the office location(s) for a dentist with basic 
details and contact information. When you are viewing a business entity or service office, 
it lists that location. Click an Office Name link to view location details on the Provider 
Location Detail page. 

 Provider Network Affiliations – This section does not display for the Business or 
Location. For the Dentist it will display the networks they are in for that office.  

 Provider Affiliations – If you are viewing a business entity, this section lists all the 
service offices. If you are viewing a service office, it lists all the dentists in that service 
office. It has no entries for a dentist. 

 Hospital and Group Affiliations – This section lists all the Hospital and Group 
affiliations for the dentist. 

 Patient Restrictions – When you are looking at a dentist, this section lists any 
restrictions the dentist has on accepting patients for each of their networks. It has no 
entries for a business entity or service office.  

 Provider Employees – This section lists the employees at this business entity or 
service office/location. Click a Name link to view an employee’s details on the Dentist 
Employee Detail page 

 User Account Information – This section only appears for an individual dentist at tier 3.  
It is used to display the user account information for the selected dentist you are viewing, 
but since we are not currently adding users at tier three, it should be blank. 
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Provider Portal User Guide  Administration Menu 

Revision Date: 1/14/2019  24 

AAddddiinngg  BBiilllleedd  AAmmoouunntt  LLiissttss 
The billed amount lists allow you to create a list of procedure codes with a specific billed amount 
for each procedure code and associate that list with a specific service office or provider. When 
submitting claims via the web, the billed amount will automatically populate the claim. 

1. You cannot associate a billed amount list with a business entity or a client specific plan.  

2. The list you associate with your office is the default for all dentists in the office and all claims 
submitted via the portal use the billed amounts in that list. 

NNoottee::    A service office can only be associated with a single billed amount list. 

If a dentist uses different billed amounts for certain procedures, you can add and associate an 
additional list with that dentist: 

 The codes and billed amounts in this list override the default office list (you only need to 
add the codes with billed amounts that are different from the office defaults).  

 You can only associate a single billed amount list with each unique Service 
Office/Provider combination. 

NNoottee::    If a Service Office/Provider combination is listed on a claim, the system checks the 
configured Billed Amount List (Fee Schedule) for that Service Office/Provider 
combination for a billed amount for each procedure in the claim. If a procedure is not 
found in that list, it checks the default Billed Amount List for the Service Office. 

 

WWAARRNNIINNGG::    A billed amount list and its associations can only be edited or deleted by the Tier 

that created the list. If a business entity user (Tier 1) creates a list, service office 

users (Tier 2 users) can only view the list and associations; they cannot delete or 

edit the list and its associations. 

A specific billed amount list can be associated with multiple service offices or service 
office/provider combinations: 

 If you want to use an office default list across multiple service offices, a business entity 
user (Tier 1) should create the list and associate it with all the service offices that are 
using that list as their default billing amounts. 

 If the business is managing all service office billing lists and associations, be aware that 
service office users (Tier 2) cannot edit the lists or associations. 

 If service office users are going to manage the service office/provider associations, 
these lists need to be created by a service office user in each service office. 

For Fee Schedules that have been manually populated into the portal from the old Fee 
Schedule system (PWP): 

 Existing fee schedules are populated into the portal as billing lists at the service office 
level (Tier 2). 

 Only service office users (Tier 2) can edit these lists and associations. 

 If you are a business entity user (Tier 1), you need to have a user login at each service 
office to edit these existing fee schedules (billing lists) and associations. A Provider 
Super User can create these user account logins, see the “DQ Provider Portal Admin 
Guide” for more information on how a Provider Super User can create and manage 
business entity and service office user accounts. 
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AAdddd  aa  BBiilllleedd  AAmmoouunntt  LLiisstt  
1. Select Administration > Billed Amount List from the portal menus on the left. 

 
2. Click the Add Billed Amount List link. 

 

3. In the Billed Amount List Name field, enter the name you want the list to have. 

4. To add a procedure code to the list: 

a. In the Code field under the Billed Amount List Detail section, enter the first code 
you are adding to this list (the 4 digit procedure code must be preceded by a “D,” for 
example, D1110). 

b. The Description automatically populates. 

c. In the Fee Amount field, enter the amount you bill for this procedure code. 

d. Click the plus arrow  to the right to add a row and repeat step 4 for each 
procedure code you are adding to this list. 
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5. Once you have added all the procedure codes and fee amounts, click the Submit 
button. 

 
6. On the Billed Amount Detail page that appears, click the Add Billed Amount 

Association link. 
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7. On the Add Billed Amount List Association page: 

a. In the Service Office field, select the service office you want to associate this list 
with from the drop-down list. 

b. Select a dentist if necessary: 

 If this list is the default billed amount list for the service office, do not select a 
dentist. 

 If this billed amount list is for a specific dentist in the office, select that dentist 
from the Associated Provider drop-down list. 

NNoottee::    A billed amount list can be associated with more than one specific dentist if 
necessary. 

8. Click the Add button to add the association. 

 

 The billed amount list and association is now active for this service office. 
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AAdddd  aann  AAssssoocciiaattiioonn  ttoo  aann  EExxiissttiinngg  LLiisstt  
Adding an association to a billed amount list assigns (associates) the list to a service office or 
individual dentist. 

1. Select Administration > Billed Amount Associations from the portal menus on the 
left. 

2. Click the Add Billed Amount Association link. 

 
3. On the Add Billed Amount List Association page, select the billed amount list you 

want to add an association to from the Billed Amount List drop-down list. 

4. In the Service Office field, select the service office for this association from the drop-
down list. 

5. Select a dentist if necessary: 

 If this list is the default billed amount list for the service office, do not select a dentist. 

 Otherwise, select a dentist from the Associated Provider drop-down list. 

6. Click the Add button. 
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EEddiitt  aa  BBiilllleedd  AAmmoouunntt  LLiisstt  
1. Select Administration > Billed Amount List from the portal menus on the left. 

2. To delete a list, click the Delete link in that list’s row on the right side. 

NNoottee::    You must remove all associations from a list before you can delete it, see step 4. 

3. Click on the Billed Amount List Name link for the list you want to edit. 

 
4. On the Billed Amount Detail page: 

 To add another association, click the Add Billed Amount Association link.  
See “Add an Association to an Existing List” for more information. 

 To remove an association from the list, click the Unlink link on the right side of that 
association’s row in the Billed Amount List Associations section. 

 To add or edit procedure codes, click the Add or Edit Codes link. 
See “Add a Billed Amount List” for more information. 

 To delete a procedure code from the list, click the Delete link on the right side of that 
procedure code’s row in the Billed Amount List Details section. 
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Claims/PreClaims/Pre--Estimates MenuEstimates Menu  

The Claims menu on the left side of the page includes the following menu items: 

 

1. Claim/Pre-Estimate Status Search 
Use this menu to search for the status of a claim or pre-estimate. 

2. Consolidated Explanation of Benefits 
Use this menu to search for claim payment information associated to a specific claim. 

3. Dental Claim Entry 
Use this menu to submit a claim. 

4. Dental Pre-Estimate Entry 
Use this menu to submit a pre-estimate. 

5. Dental Claim Confirmation Report 
Use this menu to view and/or print a report for all the claims and pre-estimates you have 
submitted for the day. 
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CCllaaiimm  CCooddeess  aanndd  DDeessccrriippttiioonnss  
The following table lists and describes the claim status for your claims, pre-estimates, and 
referrals (when applicable) in the Portal. 

Description Definition 

Successfully 
Entered 

The claim/pre-estimate has been successfully entered. This status only 
applies to claims entered through the portal. 

Accepted The claim/pre-estimate has been accepted into the claim adjudication 
system. This status only applies to claims entered through the portal.  

In Process The claim/pre-estimate is being processed in the claim adjudication 
system. 

Adjudicated The claim/pre-estimate has been determined. Waiting to process payment 
in the next pay cycle. 

Finalized The claim/pre-estimate has completed processing and payment (or 
approval for a pre-estimate). No more action will be taken. 
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CCllaaiimm//PPrree--EEssttiimmaattee  SSttaattuuss  SSeeaarrcchh  
The Claim/Pre-Estimate Status Search menu allows you to open the Claim/Pre-Estimate 
Status Search page and conduct a claim or pre-estimate search by identifying the patient 
and/or dentist. 

NNoottee::    Tier 2 service office users can view information for the dentists assigned to their 
service location. Business entity users can view all information. 

SSeeaarrcchh  ffoorr  tthhee  SSttaattuuss  ooff  aa  CCllaaiimm//PPrree--EEssttiimmaattee  
1. Click the Claim/Pre-Estimate > Claim/Pre-Estimate Status Search menu from the Portal 

Menus on the left side of the page. 

2. Enter at least one search criteria: 

 If you know the member’s first name, type it into the Member First Name field. 

 If you know the member’s last name, type it into the Member Last Name field. 

 If you know the member number, type it into the Member Number field. 

 If you know the member’s date of birth, type it into the DOB field. 

 If you know the member’s gender, select it from the Gender dropdown. 

 If you know the dentist, select the dentist from the Servicing Treating Dentist drop-
down list. 

 If you know the claim/pre-estimate number, type it into the Claim/Pre-Estimate 
Number field. 

 Select the  option if you are looking for a claim that has related 
claims associated with it. This is for claims that have been split and have associated 
claim numbers. 

 In the Claim Type drop-down list, select whether you want to search for claims or 
pre-estimate. Leave it blank to search for both. 

 

 If you know the status category of the claim/pre-estimate, select it from the Claim 
Status Cat drop-down list. Leave it blank to search all the claims/pre-estimates in 

the system regardless of status. 
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 If searching for a claim, and you know the date range for the claim’s Date of Service, 
type in the Service Date From and To dates or select the dates from the pop-up 
calendar, see “Select a Date Using the Pop-Up Calendar”. 

 If you know the date range for the claim/pre-estimate Received Date, type in the 
Claim Received Date From and To dates or select the dates from the pop-up 
calendar, see “Select a Date Using the Pop-Up Calendar”. 

NNoottee::    Using the received date is useful when you are looking up pre-estimates, which do 
not have date of services. 

3. Click the Search button at the bottom of the page. 
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The Claim/Pre-Estimate Status List page appears with any claims and/or pre-
estimates that meet your search criteria.  

NNoottee::    Dates of Service will not appear for Pre-Estimates. 

 To view the member’s details, click the Member Name link. For more information, 
see “View Member Details”. 

 To perform a new search, click the Search Again button. 

 To perform an EOB search, click the RA Search button.  

NNoottee::    Remittance Advice (RA) = Consolidated Explanation of Benefits (CEOB) 
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VViieeww  CCllaaiimm//PPrree--EEssttiimmaattee  SSttaattuuss  DDeettaaiillss  
1. Find the claim/pre-estimate status you want to view. 

2. In the Results section on the Claim/Pre-Estimate Status List page, click the 
Claim/Pre-Estimate Number link for the claim/pre-estimate status you want to view. 

The Claim/Pre-Estimate Status Detail page appears. 

 
This page contains the following sections: 

 Member Information – contains information about the patient. 

 Servicing Dentist Information – contains information about the dentist. 

 Claim/Pre-Estimate Information – contains information about the claim/pre-
estimate. 

 COB Information – contains information about Coordination of Benefits, if available. 

 Service Line Information – contains information for each service (procedure) in the 
claim/pre-estimate and processing policies (when applicable). 

 Processing Policies – contains information on any applicable processing policies 
for the claim/pre-estimate, if available. This only displays if there are Processing 
Policies on the claim. 

 File Attachments – lists any files that have been attached to the claim/pre-estimate. 
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Provider Portal User Guide  Patient Menu 

Revision Date: 1/14/2019  37 

CCoonnssoolliiddaatteedd  EExxppllaannaattiioonn  ooff  BBeenneeffiittss  
The Consolidated Explanation of Benefits menu allows you to open the Consolidated 
Explanation of Benefits search page and search for claim payment information associated 
with a specific claim or to view the capitation roster and payments made to your office. A “+” 
next to the payer name will indicate it is a roster payment. This roster represents the member 
list that was in effect when the payment was made. To see a current roster use the Panel 
Roster link in the Patient section on the left toolbar.  

NNoottee::    Roster information will only display if the employer group has a plan that uses 
rosters.  

  

SSeeaarrcchh  ffoorr  aann  CCoonnssoolliiddaattee  EExxppllaannaattiioonn  ooff  BBeenneeffiittss  
1. Select the Claims/Pre-Estimates > Consolidate Explanation of Benefits menu from 

the Provider Menus on the left side of the screen.   

2. Click on the Check or EFT Trace number or to narrow down your search, enter the 
search criteria you have into the appropriate fields: 

NNoottee::    There is no mandatory information, the search finds the Consolidated Explanation of 
Benefits (CEOB) related to the information you enter. 

a. Type the check or EFT trace number into the Check or Eft Trace Number field. 

b. Select the payment type from the Payment Type drop-down list. 

c. Enter the payer in the Payer Name field. 

d. Enter the payee in the Payee Name field. 

e. Enter a Check/EFT release date or date range to narrow down the search results: 

 Type the Check/EFT release date into the Check/EFT Release Date field or 
select it from the pop-up calendar. 

OR 

 Enter a Check/EFT release date range (From and To dates) in the Date Range 
fields (or select the dates from the pop-up calendars). 
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3. Click the Search button. EOBs for this search appear in the Results section. 

 
4. To view an EOB and see what claims are included, click the Check or EFT Trace 

Number link for that EOB. A PDF file opens for the EOB.  

 

 

NNoottee::    There are three types of EOBs:  
1. Paid by check 
2. Paid by EFT 
3. Not Applicable – this means there was no payment, but the EOB has other 
information, such as adjustments. “Not Applicable” shows under the Check Or Eft 
Trace Number column in the Results section for these EOBs. 
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DDeennttaall  CCllaaiimm  EEnnttrryy  
The Dental Claim Entry menu allows you to open the Dental Claim Entry page and enter a 
new claim. 

 

There are five sections to the Dental Claim Entry page: 

1. Basic Information – enter the basic office information for the claim in this section. 

2. Member Eligibility – enter member information in this section. 

3. Service Lines – enter the services related to the claim in this section. 

4. File Attachments – attach any files you need for the claim in this section. 

5. Optional information – you can select the COB option, EPSDT option, Emergency 
option, enter optional accident information, and enter your NEA Attachment ID (if you are 
using the NEA to submit an attachment with this claim) in this section. A COB section 
only appears on the page if you select that option. 
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EEnntteerr  aa  NNeeww  CCllaaiimm  
1. Select the Claims/Pre-Estimates > Dental Claim Entry menu from the Provider Menus 

on the left side of the screen. 

2. In the Basic Information section, enter the basic office information for the claim: 

a. Enter a service date in MM/DD/YYYY format for this claim in the Date field. 

b. Select the service office from the Service Office drop-down list. 

NNoottee::    The service offices only appear in the Service Office drop-down after you have 
entered a service date in the correct format. The address for a service office 
appears as help text when you hold the mouse over a service office.  

 

c. Select the dentist from the Treating Dentist drop-down list. 

d. Select the type of facility from the POS drop-down list. 

 
3. In the Member Eligibility section, enter the member’s information: 

a. Enter the member’s date of birth in the DOB field. 

b. Enter the member’s ID in the Member ID field, or enter the member’s first and last 
name in the Name fields. 

NNoottee::    The system identifies the member and displays their eligibility status, Active, 
Inactive, or Not Found. 

c. Once the member is identified, click the Show Member Service History button to 
view their service history. Click the main screen to return to the Claim Entry form. 

 

NNoottee::    The Service History pop-up window that appears lists the most recent services that 
DentaQuest has processed for this member regardless of the plan or dentist.  
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4. In the Service Lines section, enter the procedures for this claim: 

a. Enter the procedure code in the Procedure Code field.  
The description automatically appears. 

b. Enter the tooth number in the Tooth field, if applicable. 
c. Select the Surface, Quad and Arch for the procedure from those drop-down lists, if 

applicable. 
d. Enter a quantity (if different than 1) in the Qty field. 
e. If the service date for this procedure is different than the service date entered for the 

claim, enter the procedure’s service date in the Service Date field. 
f. Enter your authorization/estimate number in the Auth No field.  
g. Enter the billed amount in the Billed Amt field. 

NNoottee::    This is automatically populated if the procedure is included in a billed amount list 
associated with the service office or dentist for this claim. 

h. Click the plus icon  to add a new procedure row and repeat the previous steps for 
each procedure you are entering in this claim. 

NNoottee::    Click the minus icon  in a procedure’s row to remove it from the claim. 
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5. Use the File Attachments section to attach any files to this claim:  

a. Select the type of report you are attaching from the Report Type drop-down list. 

b. Click the Add File button to browse and select a file. 

 

 

c. Click Browse and locate and attach the appropriate file. 

d. Click Submit. 

 

6. Enter any notes (such as an NEA Attachment ID) associated with this claim into the text 
field in the Optional Information section. 

NNoottee::    There is a 225 character limit in the Note field.  The following characters cannot be 
entered in the Note field:  ; \ { } [ ] “ % ~ * :  
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7. If the claim is related to an emergency/accident, enter the accident information in the 
Optional Information section: 
a. Select the Emergency check box. 
b. Select the type of accident from the Accident Type drop-down list. 
c. Enter the office reference and referral numbers in the Office Ref# and Referral # 

fields. This data is saved in the claim. 
d. Select the Accident State in the Accident State field. 
e. Enter the date of the accident in the Accident Date field. 

 



Provider Portal User Guide  Patient Menu 

Revision Date: 1/14/2019  44 

8. If this claim is an EPSDT claim, click the EPSDT check box in the Optional Information 
section. 

 

9. If there is any coordination of benefits information related to other coverage for the 
member and this claim, select the COB check box. 
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10. Add other payers: 

a. Click the  button next to the Other Payer field to select a payer. 

 

b. Click the Select button next to the payer’s name to select them. If the list is too large 
enter a carrier name or number in the search fields and click Search. 

c. Click the plus button  to the right of the Other Payer entry and repeat this step to 
add an additional payer.  

You can search for the payer by insurance name or company number. 

 
d. Click the Clear button to remove a payer from the Other Payer field. 

 

e. Enter the subscriber’s information for this payer into the COB fields. 

f. If there are addition payers, click the + to add another row and repeat this step to 
add another payer. 

11. To enter COB information for an individual procedure: 

a. Click the COB button for the individual procedure. 

b. Select the payer from the Other Payer drop-down list. 

c. Enter the payment date and the amount paid. 

d. Click the plus button  to the right of the Other Payer entry and repeat this step to 
add an additional payer to this service line. 

 

12. To submit the claim once you have entered all your claim information, click the Submit 
button at the bottom of the page. You will receive a confirmation message along with the 
assigned claim number. 
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13. If you have any additional claims to enter with the same Date of Service as the previous 

claim, click . If you have to enter another claim with a different 

Date of Service, click  and begin from step 1. 
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DDeennttaall  PPrree--EEssttiimmaattee  EEnnttrryy  
The Dental Pre-Estimate Entry menu allows you to open the Dental Pre-Estimate Entry page 
and enter a new claim. 

  

There are five sections to the Dental Pre-Estimate Entry page: 

1. Basic Information – enter the basic office information for the claim in this section. 

2. Member Eligibility – enter member information in this section. 

3. Service Lines – enter the services related to the pre-estimate in this section. 

4. File Attachments – attach any files you need for the pre-estimate in this section. 

5. Optional information – you can select the EPSDT (emergency) option, enter optional 
accident information, and enter your NEA Attachment ID or other electronic attachments 
IDs (if you are using the NEA to submit an attachment with this claim) in this section. 
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Enter a New Pre-Estimate 

1. Select the Claims/Pre-Estimates > Dental Pre-Estimate Entry menu from the Provider 
Menus on the left side of the screen. 

2. In the Basic Information section, enter the basic office information for the pre-estimate: 

a. Select the service office from the Service Office drop-down list. 

NNoottee::    The address for a service office appears as help text when you hold the mouse over 
a service office.  

b. Select the dentist from the Treating Dentist drop-down list. 

c. Select the type of facility from the POS drop-down list. 

 

 

3. In the Member Eligibility section, enter the member’s information. 

4. Enter the member’s date of birth in the DOB field. 

5. Enter the member’s ID in the Member ID field, or enter the member’s first and last name 
in the Name fields. 

NNoottee::    The system identifies the member and displays their eligibility status, Active, 
Inactive, or Not Found. 

6. Once the member is identified, click the Show Member Service History button to view 
their service history. Click again to return to the Pre-Estimate Entry form. 

 

NNoottee::    The Service History pop-up window displays the most recent services that 
DentaQuest has processed for this member regardless of the plan or dentist. 
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7. In the Service Lines section, enter the procedures for this pre-estimate: 

a. Enter the procedure code in the Procedure Code field. 
The description automatically appears. 

b. Enter the tooth number in the Tooth field, if applicable. 

c. Select the Surface, Quad and Arch for the procedure from the drop-down lists, if 
applicable. 

d. Enter a quantity (if different than 1) in the Qty field. 

e. Enter your estimate number in the Auth No field. 

f. Enter the billed amount in the Billed Amt field.  

NNoottee::    Pre-estimates never auto-populate this field – they do not retrieve the billed amounts 
from any associated billed amount lists. 

NNoottee::    Click the plus icon  to add a new procedure row and repeat the previous steps for 
each procedure you are entering in this pre-estimate. 

NNoottee::    Click the minus icon  in a procedure’s row to remove that procedure. 

 
8. Use the File Attachments section to attach any files to this claim:  

a. Select the type of report you are attaching from the Report Type drop-down list. 

b. Click the Add File button to browse and select a file. 

 

 
c. Click Browse and locate and attach the appropriate file. 

d. Click Submit. 
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9. Enter any notes (such as an NEA Attachment ID) associated with this claim into the text 
field in the Optional Information section. 

NNoottee::    There is a 225 character limit in the Note field.  The following characters cannot be 
entered in the Note field:  ; \ { } [ ] “ % ~ * :  

 

10. If the pre-estimate is related to an emergency/accident, enter the accident information in 
the Optional Information section. 

a. Select the Emergency check box. 

b. Select the type of accident from the Accident Type drop-down list. 

c. Enter the office reference and referral numbers in the Office Ref# and Referral # 
fields. 

d. Enter the date of the accident in the Accident Date field. 
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11. If this pre-estimate is an EPSDT pre-estimate, click the EPSDT check box in the 
Optional Information section. 

 
12. To submit the pre-estimate once you have entered all your pre-estimate information, 

click the Submit button at the bottom of the page. 
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DDeennttaall  CCllaaiimm  CCoonnffiirrmmaattiioonn  RReeppoorrtt  
The Dental Claim Confirmation Report menu allows you to open the Dental Claim/Pre-
Estimate Confirmation Report page and view a list of all the submitted claims and pre-
estimates for the day. You can run this report at the end of the day and save it (or print it) for 
your records. This report is cleared out nightly. 

 

1. You can narrow the report down by selecting a specific office, dentist, and/or type (claim or 
pre-estimates), and then clicking the Search button.  

NNoottee::    Leave the Claim Type blank to view claims and pre-estimates. 

2. Use the Report Sort Order drop-down list to select a specific order in which you would like 
the claims/pre-estimates to appear, and then click the Search button. 
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Patient MenuPatient Menu  

The Patient menu on the left side of the page contains the following menu items: 

   

1. Member Eligibility Search 
Use this menu to view detailed member information, such as eligibility and other health 
coverage. 
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PPeerrffoorrmmiinngg  aa  MMeemmbbeerr  EElliiggiibbiilliittyy  SSeeaarrcchh    
To check eligibility, you need information about the member, the provider, and the anticipated 
service date. If you feel a member is eligible for service but the results of a search indicate the 
member is ineligible, please contact a customer service representative. Due to the changing 
nature of eligibility, the eligibility status does not guarantee payment and is subject to change 
without notice. 

You can perform an eligibility check on multiple members at once. The members you can 
search are limited to the members in your affiliated provider network(s). 

NNoottee::    All required fields are marked with a red asterisk (*). 

1. Click the Patient > Member Eligibility Search menu from the Portal Menus on the left 
side of the page to display the Member Eligibility Search page. 

  

2. Select a valid service office and dentist combination from the Select a Location and 
Provider drop-down list.  

3. Enter the member(s) for whom you want to perform an eligibility search:  

NNoottee::    All required fields are marked with a red asterisk (*). 

a. Enter the service date or select it from the pop-up calendar in the Eligible as of Date 
field. 

b. Enter the DOB (date of birth) or select it from the pop-up calendar in the DOB field.  

c. You must include either the member number OR the member’s last name and part of 
the first name: 

 Type in the member number in the Member No field or 

 Type in the member’s last name and part of the first name in the First Name or 
Last Name fields. 

d. Repeat this step for each member you are searching. 

4. To add additional rows, click the Additional Search Lines button. 

NNoottee::    You can search for up to thirty members at a time on this screen. 

5. To remove a member from the search, click the Delete link at the end of the row for that 
specific member. The row is automatically removed from the page. 
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6. Click the Search button.  
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The Member Eligibility List page displays whether the members you searched for were active 
and ineligible on the dates you entered. There will also be a “Not Found” section when 
necessary. 

There are three sections on this page – each member will appear in the section that is 
appropriate for the service date entered for that member: 

1. Active (Eligible): the member's coverage is active for the service date entered. 

2. Ineligible (Not Eligible): the member’s coverage is not active for the service date 
entered. 

3. Not Found (Member Not Found): a matching member could not be identified or the 
provider is not contracted to accept the member's plan on the service date entered. This 
section only appears if one of the members searched for is not found. 

The Member Eligibility List page contains general member eligibility information. Click Search 
Again to redisplay the Member Eligibility Search page and repeat the search process. 
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VViieeww  MMeemmbbeerr  DDeettaaiillss  
On the Member Eligibility List page, click a Member Name link to display the Member Detail 
page for that member. 

 

 

There are five sections on this page: 

1. Family section – lists the member’s name and number. 

2. Member section – lists the member information and has links to view additional 
information in the upper-right corner. 

3. Eligibility Information section – lists the plan for this member. 

4. Primary Care Dentist section – lists the Primary Care Dentist for the member on 
Capitation Plans, when applicable.  
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VViieeww  aa  MMeemmbbeerr’’ss  BBeenneeffiitt  MMaaxxiimmuumm  
If a member has benefit maximums, the Benefit Maximum section of the portal allows you to: 

 View a member’s eligibility. 

 View a member’s maximum limit. 

 View the amount of dollars that have accumulated or been applied toward a member’s 
maximum. 

 View the benefit maximum remaining balance for a member. 

NNoottee::    This section will be blank if the member does not have a maximum. 

 
To view a member’s benefit maximum, you can click on Benefit Usage from the Member 
Eligibility List page or you can access it from the Member Detail page. The Member Detail 
page can be accessed from any menu option that allows a member search. 
 
To access from the Member Detail page: 

1. Access the Member Detail page by searching for the member through any menu 
option that performs a member search (i.e.  Member Eligibility Search). 

2. From the Member Detail page, click View Benefit Maximums. The Benefit 
Maximums page will display. 
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The Benefit Maximum page has three sections: 

 Search. 

 Member Information. 

 Benefit Maximums and Deductibles. 

 

 

 

The Benefit Maximums and Deductibles section provides all the plan benefit maximum 

information. 

 

 

Column Heading Description 

Type The type of benefit: 

 Out of Pocket Maximum 

 Lifetime Maximum 

 Deductible 

Level 
The type of coverage, for example: 

 Individual 

 Family 
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Column Heading Description 

Network The network where the benefit type is applied: 

 In Network 

 Out of Network 

 All Networks 

Benefit Period The date range for the benefit maximum/accumulator.  

Period  

 

 

Time period for the maximum benefit: 

 Annual 

 Quarterly 

 Lifetime based on time period 

Unit The form of currency. 

Limit The total amount the member is entitled to per period 
qualifier. 

Applied The total amount used against the benefit limit amount 
from the current period. 

Remaining The amount remaining of the benefit limit amount for 
the time period displayed. 

 

3. When you have finished viewing the benefit maximum information for the member, 

click to return to the Member Detail page. 
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VViieeww  MMeemmbbeerr  CCllaaiimmss  
1. In the Member section of the Member Detail page, click the View Claims link.  

  

The Claim/Pre-Estimate Status List page appears with the claims submitted for this 
member.   

 

2. To view details on a claim, click the Claim/Pre-Estimate Number link. See the Claim 
Search Section for additional details.  

3. To perform an EOB search, click the RA Search 

NNoottee::    Remittance Advice (RA) = Explanation of Benefits (EOB). 

4. Use the breadcrumb trail to redisplay the Member Detail page. 
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VViieeww  MMeemmbbeerr  SSeerrvviiccee  HHiissttoorryy  
1. In the Member section of the Member Detail page, click the View Service History link.  

 

  

The Member Service History page appears with the service history of paid claims for 
this member. Each procedure is listed with: 

 A procedure code. 

 A procedure code description. 

 The tooth quad arch, if applicable. 

 Place of service. 

 The date of service. 

2. Click the Done button to return to the Member Detail page. 
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TToooollss  MMeennuu  
Click the Tools menu to display the menu items: 

  

1. User Profile 
Use this menu to view your user information and change your name, password, security 
question and email address. 

2. Find a Dentist 
Use this menu to search for a specific type of dentist, view detailed provider information, 
and get directions to a dentist’s office. 

3. Inbox 
Use this menu to view any messages sent to you by DentaQuest. 

4. Contact DentaQuest 
Use this menu to send secure messages to DentaQuest. 

VViieewwiinngg  tthhee  UUsseerr  PPrrooffiillee  
The Tools > User Profile menu on the left side of the page allows you to open the User Profile 
page and change your name, password, security question, and email address. 

EEddiitt  YYoouurr  UUsseerr  PPrrooffiillee  
1. Edit any information you want to update: 

 To update your name, edit the name fields in the Personal Information section. 

 To change your password, type the old password into the Old Password field in the 
Change Password section, type a new password into the Password field, and then 
type the new password into the Confirm Password field. 

Note: Your password needs to be 8 to 16 characters, contain at least one upper case, one     

          lower case and one number and/or special character. You cannot use the following 

          special characters: (;, \, { , }, [, ], “, %, ~, *, : ). You are prompted to change your   

          password every 60 days and cannot re-use any of the last ten passwords you have  

          used. 

 To change your email address, type your new email address into the Email field in 
the Email Address section. 

 To edit your security question, select a security question from the Password 
Question drop-down list in the Security Question section and type your answer into 
the Password Answer field.  
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2. To save your changes and return to the Home page, click the Submit button.    
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FFiinnddiinngg  aa  DDeennttiisstt  

The Tools > Find a Dentist menu on the left side of the page allows you to open the Find a 
Dentist page and search for a dentist or office, get directions, and view detailed provider 
information. You can search all dentists, which allows you to offer your members referrals to 
offices according to their needs.  

 

 

1. In the Plan section, select the product the member is covered under.  

          

 

2. In the Your Location section, enter at least the required address fields.  

 

3. In the Sorting, Distance and Number of Results section (optional), select the: 

 Maximum miles willing to travel and  

 Number of Results to preview. 

   

4. In the Additional Search Criteria section enter any of the following (optional): 

 Dental Provider Last Name. 

 Practice Name. 

 Specialty. 

 Accepting New Patients.  

5. Click . This displays the Dentist Directory List page.  
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UUssiinngg  YYoouurr  IInnbbooxx  
The Tools > Inbox menu on the left side of the page allows you to open the Inbox page and to 
view any messages sent to you by DentaQuest.  

NNoottee::    Most messages sent to you from DentaQuest are in response to messages you sent 
to DentaQuest using the Contact DentaQuest page. For more information, see 
“Contacting DentaQuest”.  

If you have new messages in your Inbox, you can also click the Inbox link in the upper-right 
corner of the Message Center that appears on your Home page to open the Inbox page. 

NNoottee::    All communication via the portal is secure from a HIPAA/PHI standpoint. 

  
Use your Inbox to read and manage your messages. You can navigate between the Inbox, 
Sent Items, and Deleted Items using the links in the upper-right corner of the Search section. 

1. To display a message, click the Subject link for that message. 

2. To delete a message, click the Delete link for that message. 

3. To display the messages you have sent, click the Sent Items link. 

4. To display the messages you have deleted, click the Deleted Items link. 

SSeeaarrcchh  YYoouurr  MMeessssaaggeess  
1. Type a subject into the Subject field in the Search section, or type a date range into 

Date Range fields (or use the pop-up calendars). 

2. Click the Search button. 
The messages in the Results section are narrowed down according to your search 
criteria. 
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VViieeww  aanndd//oorr  DDeelleettee  aa  MMeessssaaggee  
1. Click Inbox under the Tools menu to view your messages. 

2. If necessary, use the Search section on your Inbox page to find the message you want 
to view. 

3. Click the Subject link for the message you want to view. 

The View Message page appears. 

4. To view message details, click the View Detail link. 

 

5. To view an attachment, click the Download link for that attachment. 

6. To remove the selected message, click Delete. In the dialog that appears, click OK to 
delete the message or Cancel to return to the View Message page for that message. 

7. Use the breadcrumb trail to return to your Inbox. 
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CCoonnttaaccttiinngg  DDeennttaaQQuueesstt  
The Tools > Contact DentaQuest menu on the left side of the page allows you to open the 
Contact DentaQuest page and send secure messages to DentaQuest. 

NNoottee::    All communication via the portal is secure from a HIPAA/PHI standpoint. 
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SSeenndd  aa  SSeeccuurree  MMeessssaaggee  ttoo  DDeennttaaQQuueesstt  

NNoottee::    Required fields are marked with a red asterisk (*). 

1. Select Customer Service from the Message Type drop-down list.   

2. Type your question or comment in the Description text box. 

  

3. You can add an attachment, a claim/pre-estimate, a member or a provider record to your 
message. Follow: 

a. Step 4 to add an attachment.  

b. Step 5 to add a claim/pre-estimate.  

c. Step 6 to add a member. 

d. Step 7 to add a dentist. 

4. To add an attachment: 

NNoottee::    You can only have one file attachment per message. If you have multiple files or file 
types you can attach them as a zip file. You can also indicate a NEA # or electronic 
attachment in the comment box.  

a. Click the Upload link.  
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b. In the Upload Attachment page that appears, click Browse. 

 

c. Use the Choose File window that appears to navigate to and select the file you want 
to upload. 

d. Click the Submit button to upload the file you selected. You can click the View link to 
view the attachment or click the Remove Attachment link to remove the attachment. 
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5. To add a claim/pre-estimate (one per message): 

NNoottee::    You can only add one claim/pre-estimate per message. 

a. Click the Search magnifier icon in the Claim/Pre-Estimate Number section.  

   
b. On the Claim Status Search page that appears, search for and select the claim you 

want to add to this message. For more information, see “See Claim/Pre-Estimate 
Status Search”. 

c. To remove a claim as an attachment, click the Clear Claim button. 

6. To add a member: 

NNoottee::    You can only add one member per message. 

a. Click the Search magnifier icon in the Member Number section. 

                    
d. On the Member Eligibility Search page that appears, search for and select the 

member you want to add to this message. For more information, see “See 
Performing a Member Eligibility Search”. 

b. To remove a member, click the Clear Member button. 

7. To add a dentist: 

NNoottee::    You can only add one dentist per message. 

a. Click the Search magnifier icon in the Dentist Name section. 

 

b. On the Dentist List page that appears, search for and select the dentist you want to 
add to this message. For more information, see “Using the Dentist List”. 

c. To remove a dentist, click the Clear Dentist button.   

8. Click the Submit button to send the message.  
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OOther Home Page Itemsther Home Page Items  

UUssiinngg  tthhee  FFAAQQ  LLiinnkk      
Click the FAQ link in the upper-right corner of your Home page to display the View FAQ 
(Frequently Asked Questions) page.  
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UUssiinngg  tthhee  EEvveenntt  CCaalleennddaarr  
1. Click the Event Calendar link on your Home page to display the Event Calendar and 

view upcoming event information that DentaQuest has posted.  

2. To view details for an event, click the Day Number link to open the Day Events page, 
which lists the details for any events that DentaQuest has set up.  

 

 

3. Use the breadcrumb trail to return to the Event Calendar. 
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VViieewwiinngg  RReellaatteedd  DDooccuummeennttss  
1. Click the Related Documents link on your Home page to display the Document List 

page. This list contains any provider documents or URL links that DentaQuest has 
posted. 

   - Items with this symbol are secure documents that you can download and save. 

  - Items with this symbol are URL links to documents (or information) on external 
sites, such as a W-9 link to the IRS website or Medicaid and Medicare URL links. 
The document or website opens in a new browser window. 

2. To search for a document, enter the Title or Description, select a file type from the File 
Detail Category drop-down list, and then click the Search button. 

3. To download and display a document or open a URL link, click the title for that document 
or link.  

 

             

 

 


